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Introduction to the Guide 
With this Userís Guide, SoftMap Technologies (2002) Inc. will familiarize you with version 4.95 of 
SoftMap Plus. You will find in the following chapters all of the information you need to master the 
features of this software package. 

Overview of Chapters and Appendices 

CHAPTER 1 
This first chapter is about installing SoftMap Plus. First, we give information on the contents of the 
installation kit and on system requirements. Second, we explain how to install and uninstall. 

CHAPTER 2 
This chapter explains how to start SoftMap Plus. First, we define what a work session in SoftMap Pro 
involves. Second, we introduce the interface and go through the different bars and windows. 

CHAPTER 3 
In this chapter we teach you how to use the different navigation tools to navigate in SoftMap Plus 
maps. Information on how to manage the maps and the map data is also given. 

CHAPTER 4 
In this chapter we tell you how to use the different measuring tools in SoftMap Plus. 

CHAPTER 5 
This chapter introduces the different printing tools in SoftMap Plus. We explain how to print maps, 
create printing zones and print them, copy data to other applications, etc. A section of this chapter 
deals with map grids. 

CHAPTER 6 
This chapter tells you about SoftMap database and layer management. It also explains how to import 
and export vector data and how to import point data from a database. Youíll also learn how to manage 
point databases and place-name databases. 

CHAPTER 7 
This chapter deals with graphic editing. First we explain how to add points (represented by symbols), 
texts, lines and polygons to the maps. Second, we explain how to display and arrange these graphic 
items. 

CHAPTER 8 
This chapter explains the procedure to import a database of addresses or coordinates. SoftMap Plus 
can accept a number of file formats ; you will find the list and the description of those files in this 
chapter.  

CHAPTER 9 
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This chapter explains, first, how to select graphic items and link information to them, second, how to 
consult the information. A section of this chapter deals with complementary data. We explain how to 
consult information linked to point data. 

CHAPTER 10 
This chapter deals with the GPS tool. First, we explain how to manage GPS databases. Second, we 
teach you how to navigate in SoftMap Maps while using a GPS receiver. We also tell you how to 
manage points and tracks, and how to use the data plotted by your GPS receiver. 

CHAPTER 11 
This chapter deals with the other tools available in SoftMap Plus. You will find the description of all the 
tools not regrouped in another chapter. 

CHAPTER 12 
This chapter presents SoftMapís Technical Support Policy. We also tell you how to report any bugs you 
may find. 

APPENDIX 1 
This appendix provides the Software Bug Report. 

APPENDIX 2 
This appendix provides legends and georeference reports. 

APPENDIX 3 
This appendix goes over the basics of map scales. 

Terminology 
Here, we explain different technical terms in plain language for both professionals and the general 
public. .  

Symbols and Conventions 

MOUSE BUTTONS 
In SoftMap Pro, you can use the right button of the mouse to access contextual menus and their 
different options. We always ask you to ìright-clickî when you have to use the right button. If we just 
ask you to click, you have to use the left button. 

MENUS, COMMANDS AND DIALOG BOXES 
The names of menus, commands and dialog boxes are always in bold with an initial capital letter, so 
you can easily spot them in the text. 

UNDERLINED ELEMENTS 
We draw attention to some key words or word groups by underlining them.  
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A Quick Run Through 

NAVIGATING IN SOFTMAP PLUS 
There are several ways to navigate in the maps: 

!" Navigational arrows (8) Ö 

Click in the navigating zone within the map frame. SoftMap Plus will move the on-screen map 
in the direction of the arrow. 

!" Move Map tool   

Click on the point you wish to move the map from. While holding the button down, move the 
mouse in the direction away from where you wish to place the map. 

!" Center Map tool   

Click on the map at the location you wish to make the central point of the new map. 

!" Navigate using Geographical Directions tool  

Click on the button on the steering wheel corresponding to the direction you want to navigate 
in. You can also click on the plus (+) or minus (-) signs at the wheelís center to zoom in or 
zoom out on the map. 

!" Change Map tool  

Click on the map and select the option of your choice, such as changing scale and zooming in 
or out. 

!" Search tool  

You can use the search modes: By place names, By coordinates, By bookmarks (see 
Adding a bookmark), By identifiers (see Erreur ! Source du renvoi introuvable.), By points 
or By address to get directly to points on the maps. Click on the tab that corresponds to your 
choice. Once youíve entered the information, click Go to. 

Note 

For other ways to navigate, go to the heading Erreur ! Source du renvoi introuvable.. 

DISPLAYING COORDINATES IN LATITUDE AND LONGITUDE 
Double-click on the right side of the status bar. Go to the dialog box that appears on-screen. Under the 
tab Display coordinates, uncheck the box Based on the map on-screen and click Apply. 

ADDING A BOOKMARK 

1. Go to the map you wish to bookmark and click Add bookmark . Type the name of the 
bookmark in the dialog box appearing on-screen and choose the property you wish to apply to it. 

Notes (1) The Home map property can be applied only to one bookmark per work session. 

It is represented by the  button. Clicking on it will take you directly to the map 
corresponding to the bookmark. 

(2) The Shared property lets you access the bookmark in all work sessions you open 
in SoftMap Plus. You can reuse the same bookmark without having to recreate it 
for several different sessions. 
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2. Validate by clicking OK. The bookmarkís name will automatically appear in the session window 
under the tab Bookmarks. 

Note Here, you can alter the properties of a bookmark by right-clicking on it. Then go to the 
context menu and select the option that interests you. 

COMPUTING DISTANCE  

1. Click either Compute distance on an ongoing basis  or Compute distance and 

azimuth . 

2. Trace your route by left-clicking on each intermediate point of the entire itinerary. 

Note In the first case, the dialog box displays only the distance and the time. In the second, 
it gives the distance of the last segment you defined, the total length of all segments, 
and the azimuth between the last two points. 

3. To erase your route, click Reset to zero . 

Note Some traces may remain visible on-screen. To erase them completely, click Refresh 

screen . 

COMPUTING DISTANCE BETWEEN A PLACE NAME AND A 
BOOKMARK 

1. Click Compute distance on an ongoing basis . Click Search  . 

2. A dialog box will open. Click on the tab By place names. Next choose the database and the 
family that interests you. Identify the place name of your choice, either by typing it in the Place 
name box or by selecting it from the pulldown menu. 

3. Next click Use. SoftMap Plus will take you directly to the map location featuring the place name 
you selected. It will be identified by a cross (+). 

Note You can first view the place nameís location on the map by using the Go to option. 

4. Next click on the tab By bookmarks, go to the pulldown menu, and select the bookmark you 
added at Add bookmark. 

5. Repeat the operations in point 3. The distance is displayed in the dialog box. 

Note 

You can also compute the distance between place names or bookmarks only. Or between coordinates, 
identifiers, or points (see Erreur ! Source du renvoi introuvable.). 

ADDING A POINT TO THE BASE MAP 
SoftMap Plus comes with a bank of symbols that may be placed anywhere you like on the territory. 

1. Go to the territory you want and click Add point . 

2. The dialog box Select symbols will appear. Select the symbol best representing what you want to 
portray. To do this, click one of the two pulldown menus and click the symbol (or symbol name) 
that suits you. 

3. Using your mouse, position the cursor at the location where you want to add the point represented 
by the symbol. Left-click to validate your choice. The symbol will appear at the spot you just 
clicked. 

Note  



 Chapter 1 17 

 

You can use Search   for this task. Find the point youíre looking for by entering a place name, 
geographical coordinate, bookmark, identifier, or point (see Erreur ! Source du renvoi introuvable.). 

DELETING A POINT ON THE BASE MAP 

1. Click Select one or more item(s) . Left-click on the symbol representing the point you wish to 
delete. 

2. Press the right mouse button to select Delete. A dialog box will open automatically and ask you to 
confirm your choice. 

DISPLAYING POINT-RELATED INFORMATION 
Points on the maps may contain information in the form of attached images or data. To view such data: 

1. Select the point you want to get information about by clicking on it with the button Select one or 

more item(s)  (the point will then appear in reversed colors). 

2. Right-click for a pulldown menu and select the option Information. 

Notes (1) The General tab provides general information on the point (identifier, database, 
and layer), its coordinates, and the geodetic reference system. This tab allows 
you to consult any notes associated with the point. 

(2) The Symbol tab allows you to change the way the point is represented. 

(3) The Images tab allows you to view any images attached to the point. 

GET ADDRESS TOOL 
The Get address tool  lets you display the civic address of a point. 

1. Click on the button Get address  on the toolbar and the window Get address will open.  

2. Position the cursor on the map at the specific point where you want to get the address and left 
click. If the address of the point is available, it will automatically be displayed in the box Get 
adress 

PRINTING A MAP 
There are two ways to print out maps with SoftMap Plus. You can print an on-screen map simply by 

clicking Print . Or, you can first define a printing zone with a cartridge and then print out the map 
using the same button. 

Select a scale covering the entire zone you wish to print. Then click Create printing zone with 

cartridge ; 
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1. On the map, click the location you want to be the central point of the printing zone. A dialog box 
will automatically appear. In it, you can specify the display properties of the zone to be printed 
(style, color, etc.) and determine the output parameters. 

 

Notes 

A cartridge will frame the printing zone on the printout or the print preview. It contains information about 
the base map and any additional data that may appear on this map. 

Printing zones are referenced and conserved in the session window under the Printing zones tab. 
Here, you can alter their properties by right-clicking on the zone you want and then selecting the 
desired option from the context menu.



 

 

Chapter 1  Installation of SoftMap Plus 

Content of Installation Kit 
If your SoftMap Plus software came as a kit, youíll have all the necessary material to use it. The kit will 
have one or more CD-ROMs containing: 

!" SoftMap Plus software. It comes with a session file containing a personal database that has 
five layers to which you can add points, text and lines. 

!" Geographical maps of the territory you choose. 

!" One or more multimedia presentations. 

!" One or more place-name database. 

!" One or more data sets. 

!" A user license for SoftMap Plus software. 

!" A user license for the map data. 

!" A userís guide in electronic format. 

!" A registration card. 

System Requirements 
An IBM-compatible microcomputer with a Pentium II 233 processor (or higher). 

128 megabytes (Mb) of random access memory.  

A minimum of 180 Mb of free space on your hard drive. 

A CD-ROM drive. 

A mouse. 

A video card that can display at least 65,000 colors. 

A desktop area at least 800 by 600 pixels. 

Windows, versions 95, 98, NT 4.0, Me, 2000 or XP. 

Installing SoftMap Plus 
The installation software transfers the data from the CD-ROM to your computer and updates the files 
needed for operation. 

Put the CD-ROM into your drive. A dialog box will automatically appear. Select the Install title name 
option. If no dialog box appears, install as follows: 

1. Make sure youíre in a Windows environment. 

4. Put the CD-ROM into your drive. 

5. In Windows taskbar, click on Start and then on Programs/Accessories/ Windows Explorer; 

6. Browse the CD-ROM and double click on install_en.exe.  

7. Follow the on-screen installation instructions. You will need the serial number during installation. 
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NoteThe install program will check to see whether you have the minimum system requirements 
to install SoftMap Pro (space available on hard drive, etc.). 
 
SoftMap Plus is a protected software but if it is installed with cartographic data in a kit, it will unlock 
automatically. Your version might require a registration key to unlock the permanent license. The 
installed version allows you a 30 day period to register your software.  In order to allow us to supply 
your registration key, we need you to give us the validation code generated by your computer when 
you are required to register during installation. It is made of 9 digits followed by 7 digits: XXXXXXXXX-
XXXXXXX 

 
Please send your validation code to info@softmaptech.com with your serial number. 

We will return your key upon receiving this code. 

Installation of SoftMap Pro on SoftMap Plus 
If you have a previous 4.XX version of SoftMap Plus (up to 4.95) on your computer, SoftMap Pro will 
delete it. The update will not affect any data from a previous version of SoftMap on your computer 
(databases, map grids, bookmarks, topographic maps, etc.). You will still be able to use such data 
while taking advantage of the new SoftMap Pro features. To find out how to retrieve the data see 
Create a New Session with the Wizard. 

Notes Some toolbars have new buttons in SoftMap Pro and will be restored at their default 
locations. If you had customized the toolbars display, you will have to do it again. 
The program groups wonít be deleted, except the one for SoftMap Plus. The SoftMap Plus 
group will be replaced with a new group named SoftMap Pro. Youíll be able to create a 
SoftMap Pro shortcut on the Windows desktop. Any shortcuts for SoftMap Plus titles will be 
renamed SoftMap Pro. 
The SoftMap Plus help file and userís guide will be replaced with their SoftMap Pro equivalents. 

Installation of SoftMap Plus on SoftMap Pro 
If, after having installed SoftMap Pro on your computer, you decide to install a SoftMap Plus title, a 
message will indicate that a newer version of SoftMap exists and that only the data from the title will be 
installed.  

Installation of SoftMap Plus on SoftMap Plus 
If after having installed SoftMap Plus on your computer, you decide to install a second title with 
SoftMap Plus, a message will tell you that SoftMap is already installed and that only the data of the title 
will be installed. If the new version is more recent, it will update the installed version.  

Starting the Software 
If, during installation, you created an icon on the Windows desktop, you can use it to start 
SoftMap Plus. Otherwise: 

1. Click Start at the bottom of the screen and then point to Programs. 

2. Go to the group called SoftMap Plus. Click the icon called SoftMap Plus. 

Uninstalling SoftMap Plus 
1. In the Windows taskbar, first click Start, then Settings, and then Control Panel. 

2. Select the Add/Remove Programs option. 

3. Go to the list of programs and select SoftMap Plus. Click Add/Remove. 

4. The uninstall program will appear. Click End to uninstall. 
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CHAPTER 2 ñ STARTING SOFTMAP PLUS 

Work Session 
What is a work session? Itís all of the data and parameters that make up your work environment at any 
point in time. It contains a session window (see Session Window ) and a map window (see Erreur ! 
Source du renvoi introuvable.).  

The map windowís position on-screen, the scale, the last image you viewed, and the databases, place 
names, bookmarks and map grids saved in the session window will be saved in the work session file. 

Create a Session 
When you start up SoftMap Plus, the dialog box Open session file automatically appears. 

. 

 

Create a New Session 
Check off Create new session. SoftMap Pro will automatically open a new session by default. Note 
that this session wonít contain any data. If you have created a bookmark with Shared in other 
sessions, it will automatically be included and displayed in the new session. 

Create a New Session with the Wizard 
The wizard can use data from a SoftMap Plus title installed on your computer to create a session file. 
The data may include databases, map grids, place names, multimedia presentations and point data. 

1. Check off Create new session, using the wizard. The following dialog box will appear: 



 Chapter 2 22 

 

 

2. Follow the instructions and use < Back and Next > to flip from one page to the next.  

NoteYou can create several work sessions with the wizard. You cannot edit any sessions that 
havenít been created with the wizard. 

Open an Existing Session  
1. Check off Open existing session file. 

2. Look through the list and select any session file you wish to open. Or click BrowseÖ 

NoteThe files installed by SoftMap Plus and SoftMap Pro installation programs are in the Session 
subdirectory of the default installation directory. 

3. In the dialog box that appears, choose the directory and name of your session (extension .SVS). 

NoteSoftMap Pro opens the map window at the map you had on display when the session was 
last saved (if the mapís source has not changed). It also opens the session window with your 
parameters. The session file name appears in the title bar of the session window. 

Save a Work Session  
Click Save  or select Save as in the File menu. A dialog box will appear. 

Close a Work Session 
Use Close in the File menu. SoftMap Pro will ask whether you wish to save the session if any changes 
have been made. 

Transferring data from the drive to the computer 
Map data may be read from the map CD-ROM or the hard drive, when copying map data manually. 

SoftMap Plus knows where to get the map data on the different removable disks. If youíve copied map 
data to your hard drive, SoftMap Plus will remember where to go as long as you havenít moved the 
data elsewhere.  
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If your map CD-ROM isnít in any drive or if the map data have been deleted or moved off your hard 
drive, SoftMap Plus will ask for the map data location using a dialog box. 

!" If you have a CD-ROM, insert it into the drive and click YES. SoftMap Plus will automatically 
detect the mapís source. 

!" If your map data are installed on the hard drive but cannot be found by SoftMap Plus, click NO 
in the dialog box. Another box will open, asking for the directory containing the map data. 

!" If you click Cancel, youíll go back to where you were before the title search dialog box 
appeared. 

How to copy map data sets to your hard drive 
You may find it useful to copy a collection of maps if youíve bought several titles. You can then work on 
two map data sets at once and thus access a larger number of map scales without continually having 
to switch CD-ROMs. 

Note   

The data sets take up between 400 and 550 Mb on the CD-ROM. A CD-ROM may have several 
thousand files that make up a map data set. When copying the Mapdata directory to your hard drive, 
make sure you have enough disk space for the transfer. Even though your hard drive shows sufficient 
available space, you may still not have enough because of the type of partitioning on your hard drive. 

For example, if you have FAT16 partitioning, each image file will occupy at least 32 Kb on your disk, 
even though the image file takes up only 10 Kb. Youíll lose 22 Kb of space for each file of this size, 
thus tripling its effective size. Consult the Help function of your operating system for further information. 

1. Create a directory on your hard drive. 

E.g. C:\SoftMap Maps\Le guide Parcs Québec\ 

C:\SoftMap Maps\Québec topo50\Volume1\Disk 1\ 

2. Insert the appropriate CD-ROM into your drive. 

3. Using your mouse and the Ctrl key on your keyboard, select the directories Mapdata and Navig 
and the files Install.inf and ìindex nameî.dat . 

Note The last file, ìindex nameî.dat, is different for each disk. 

4. Right-click and choose the Copy option. 

5. Go into the directory you created and click Paste. 

6. Once in SoftMap Plus, click Install data set  and look for the Install.inf file in the directory 
youíve just created on the hard drive. 

Note 

You can also perform this installation using  Map manager. Consult the heading Erreur ! Source du 
renvoi introuvable. to find out how to proceed. 

How to change map CD-ROMs 
If you have several map compact disks and they have each been installed (Each data set is 
automatically configured by the installation file or by the software itself when inserted in the CD-ROM 
drive), SoftMap Plus will ask for the disk containing the geographical sector you wish to navigate on. 
Each of your disks is identified by a label on top of the CD-ROM. 

You can change disks even if  SoftMap Plus hasnít asked you to. If, however, you request a map that 
isnít on the disk youíve inserted, SoftMap Plus will ask you to put back the one with the region it 
needs. 
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Interface 
This is SoftMap Plus interface by default: 
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Menu Bar 
Located at the top of your screen, he menu bar contains eight tabs on which you can click to display 
the commands for each menu. 

 

Points in common between Microsoft Windows® and 
SoftMap Plus 
About the commandsÖ 

!" When the first letter of a menu title is underlined, you can access the menuís commands from 
your keyboard. Press simultaneously ALT and the key of the underlined letter to scroll through 
the menu. 

!" When a command is followed by ellipsis points (Ö), a dialog box is associated with it. 

!" When a command is shaded gray, it is inaccessible or you have to select something else 
before you can use it. 

!" When a black triangle ( ) is to the right of a command, you can click on it and access a 
secondary menu. This menu will in turn offer another list of commands. 

!" When a command has a checkmark (#) beside it, itís active. To deactivate the command, 
delete the checkmark by clicking on it. 

!" When a combination of keys is listed to the right of a command, you can choose the command 
without scrolling through the menu. Itís called a ìhotkey.î 
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Table 1: Hotkey Examples 
Menus Commands Hotkeys 

File New 
Open 
Save 
Print map 

Ctrl+N 
Ctrl+O 
Ctrl+S 
Ctrl+P 

Edit Copy to clipboard Ctrl+C 

Display Overview 
Session window 
Multimedia button  

Shift+Ctrl+O 
Shift+Ctrl+S 
Shift+Ctrl+M 

Navigation Real size 
Home map 
Previous map 
Next map 
Search 

Shift+Ctrl+Home 
Shift+Home 
Alt+Left arrow 
Alt+Right arrow 
Ctrl+F 

Help SoftMap help F1 

To change a name in a text entry field F2 

To change map window Ctrl+(Shift)+F6 

 

About the dialog boxesÖ 
The most frequently used command buttons in the dialog boxes are: 

 validates all data entry 

 cancels all data entry and closes dialog box 

 closes dialog box 

 gives access to user support software 

 immediately validates all changes without closing the current dialog box. 



Chapter 2  28 

 

In SoftMap Plus, you can change the dimensions of the dialog boxes or move them by using the 
pointer and the mouse. 

 

 

Several SoftMap Plus dialog boxes have scrollable list boxes. The lists are marked by an arrow 
pointing downwards. Just click on the arrow and scroll down. 

 

You can access text fields either by clicking with the mouse pointer or by using TAB on the keyboard. 

Note For further information on this subject, go to the Windows userís manual. 
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Toolbars 
List of bars and their respective buttons 
SoftMap Plus features six toolbars. Each has several buttons you can click on: 

Session 

 New  Display!close overview 

 Open  Display!close multimedia button 

 Save  New window 

 Edit session with the wizard  Customize options 

 Display!close session window  Help 

Navigation 

 Move map  Zoom out 

 Center map  Real size 

 Navigate using geographical directions  Search 

 Change map  Home map 

 Previous map  Add bookmark 

 Next map  Install data set 

 Zoom in   

Selection 

 Select one or more item(s)  Select points forming a circle 

 Select points forming a rectangle  Display information 

 Select points forming a polygon   

Computation 

 Compute distance on an ongoing basis  Compute radius 

 Compute distance and azimuth  Magnetic declination 

 Compute surface area   

Graphic edition 

 Add point  Delete selection 

 Add text  Refresh screen 

 Activate a layer  Tone down map colors 

 Add line   
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Printing 

 Print  Create printing zone with cartridge 

 Print preview  Copy to clipboard 

GPS Tools 

 
Navigate using a GPS 

 
Edit routes 

 Edit waypoints  Edit tracks 

   Upload to PDA 

Other tools 

 
Metadata 

 
GeoWriteS 

 Get address  Elevation profile 
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On the other hand, many toolbars in the GPS module are part of dialog boxes, each having several 
buttons you can click on. 

Toolbar in ìNavigate using a GPSî dialog box  

Angular unit 
Distance unit 
Speed unit 
Connect to a GPS receiver 
Locate mobile on the map 
Save tracks or not 
Reduce\enlarge dialog box 

 

Help 
Toolbar in ìEdit tracksî dialog box 

Angular unit 
Locate point on the map 
Speed unit 
Delete 
Copy to clipboard 
Cancel track 
Reduce\enlarge dialog box 

 

Aide 
Toolbar in ìEdit waypointsî dialog box 

Angular unit 
Distance unit 
Locate a waypoint on the map 
Display properties 
Delete 
Copy to clipboard 
Reduce\enlarge dialog box 

 

Help 

 
Displaying tool description 
Place the mouse cursor on the button youíd like to know more about. A help balloon with a brief 
description of the tool will appear after a few moments. At the same time, a more complete description 
will appear in the status bar at the bottom of the screen. When appropriate, it will also tell you how to 
use the button. 

Moving and closing toolbars 
Toolbars can be placed wherever you like on the screen. Their position will be saved at the same time 
as the other work session parameters. 

To move a toolbar, click outside one of its buttons. While holding the mouse button down, move the 
toolbar to the desired location and then release. 

 

You can place the toolbar on the base map or in the side or top portions of the screen. On the base 
map, the toolbar takes the form of a dialog box with a closing button in the upper right cornerójust 
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click it to close the boxóand a description in the title bar. If you right-click the title bar, a context menu 
will appear and ask whether you wish to move or hide the toolbar. 

Resizing toolbars 
When a toolbar is moved on the base map, you can alter the width of its dialog boxóif the box has 
more than one buttonóand thus change the button layout. 

Place the cursor on one border of the dialog box. When a double arrow appears, press the left mouse 
button and move the mouse in the direction you wish to resize the box. 

 

Customizing toolbars 
Click the CustomizeÖ option in the Tools menu and select the ToolbarÖ command. The following 
dialog box will appear: 

 

How to customize the toolbar display 
If you want your buttons to look 3-D, uncheck the Flat buttons box. Check the same box if you want 
them to look flat. 

How to display or hide toolbars 
Go to Bars and click the box corresponding to the name of the bar you wish to hide or display. When 
the box is checked off, the toolbar is visible on-screen. 
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How to create or alter new toolbars 
1. Click the NewÖ command. A dialog box will appear. Enter the name of the toolbar in the entry 

field and click OK. An empty toolbaróin the form of a dialog boxówill appear on the left of your 
screen. 

2. To add buttons to the new toolbar (or to an existing bar), click the Commands tab and choose a 
toolbar name in the Categories field. In the Buttons field, select the button you wish to copy. 

Note Whenever you click a button, a description of it will appear in a special field. 

3. Holding the left mouse button down, move the button youíve selected to the toolbar. 

 

Notes 

(1) To delete a button, take it back to its place of origin or simply remove it from the bar. 

(2) You can move a button from one toolbar to another. You need only select the button with the 
mouse and move it to its new bar. 

(3) To restore a toolbar to its place of origin, click Default. 

How to rename or delete toolbars  
If you wish to rename or delete a toolbar youíve created, select it under Bars and enter the new name 
in the entry field. Or click Delete. 

Note You can only delete toolbars youíve created. 

Status bar 
The status bar is the bar at the bottom of your screen. It continually gives two kinds of information: (a) 
information on the different buttons and commands youíre passing your cursor over or clicking on; and 
(b) information on the map displayed in the active map window. 

From left to right, it provides you with: (a) a description of the buttons and commands as well as advice 
on how to use them, (b) geodetic reference system / horizontal coordinate system, (c) coordinates; and 
(d) graphic scale. 

 

SoftMap Plus provides advanced features for customizing the status bar with respect to most of the 
existing coordinate systems and geodetic reference systems. Users less familiar with these concepts 
should stay with the default display options.  

What if you customize the different parameters and, after making the changes, have trouble displaying 
the coordinates you want? You need only reactivate the default parameters as outlined further on. 

Note The Coordinates and Graphic scale settings cannot be altered. The information they provide 
is based on the image displayed in the map window and the coordinate system youíve 
chosen. 

Hiding or displaying the status bar 
In the Display menu, uncheck the Status bar option by clicking it. The status bar will be hidden. To 
make it visible, click the option a second time. 
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Customizing the status bar 
Click the Customize option in the Tools menu and select the Status barÖ command. Or double-click 
the status bar. The following dialog box will appear: 

!" Under the General tab, you can choose the default quadrant, the latitude-longitude symbols, 
and the scale unit. Click Apply to validate your choices. Click OK when done. 

 

!" Under the Display coordinates tab, you can customize the horizontal coordinate system and 
its display unit. You can also select an additional geodetic reference system. 

 

How to customize the horizontal coordinate system 
Deactivate the check box Based on the map on-screen. If you know the exact name of the 

coordinate system you wish to use, type it into the entry field. Otherwise, click the  button. A 
dialog box will appear and list all of the coordinate systems supported by SoftMap Plus. 








































































































































































































































































































